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Getting started

Chapter 1. Getting started

1.1 System requirements

This section describes the hardware and software system requirements.

1.1.1 Software requirements

This software is compatible with the following operating systems. Both 32-bit and 64-bit versions are
available.

• Microsoft Windows NT

• Microsoft Windows 2000

• Microsoft Windows XP

• Microsoft Windows Vista

• Microsoft Windows 7

• Microsoft Windows 8 & 8.1

• Microsoft Windows 10

Disk space

For the full installation of the software, up to 20 MB of hard disk space is required.

1.1.2 Hardware requirements

This software can be run on a basic PC and does not require powerful specifications. The following are
minimum hardware requirements for installing and running this software.

• Pentium PC

Performance is based on the following factor:

• Processor performance

1.2 Software installation

The installer can be downloaded from the ABOV website. You should ideally have the latest version of
the software because ABOV constantly adds newer devices and features. The installer package can be
executed on any Microsoft operating system.

Perform the following:

1. Execute the installer.
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Software installation

2. Once the warning message below pops up, click Yes.

3. You will see the following dialog box. Click Next.
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Software installation

4. Select I accept the items of the license agreement on the License agreement dialog box and
click Next.

5. Enter the username and company name and click Next.
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Software installation

6. Select Complete and click Next.

7. Click Install.
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Software installation

8. Wait until all the application components are installed.

9. Click Finish to complete the installation.
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Structure of CodeGen8 folders

Chapter 2. Structure of CodeGen8 folders

2.1 Structure of CodeGen8 project folder

CodeGen8 includes CodeGen8 project files in the Project folder, which is located in the CodeGen8
installation folder. All CodeGen8 project files are either \*.VPP or \*.VPD files:

• \*.VPP files contain basic information (device name, package type, pin count, etc); for example,

ABOV-CodeGen8-MC9x A1.03 20130419
MC96F6332 SOP 28

• \*.VPD files contain the target device’s peripheral property settings; for example,

B_isSingle 0
PORT001 -1 0 0 0 0
BUZ 0 2659.574463
:
:
EXTINT10 0 0 0
WDT 0 0 120

Caution: Do not modify \*.VPP or \*.VPD files.

Folder assignment:

2.2 Structure of CodeGen8 library folder

CodeGen8 includes each device’s sample files in the device’s specific library folder under the common
Library folder, which is located in the CodeGen8 installation folder. These device-specific library
folders contain the following:

• Device package definition file

• Device header file

• Sample source program files
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Structure of CodeGen8 library folder

CodeGen8 generates a standard basic source program. To see details, refer to the sample source files.

Caution: Do not delete or modify any of the files in the Library folders.

Folder assignment:
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Using CodeGen8

Chapter 3. Using CodeGen8

3.1 Features of CodeGen8

CodeGen8 supports the M8051-based MC9x/A9x series developed by ABOV Semiconductor Co., Ltd.

CodeGen8 screenshot

3.1.1 Detailed features

This software application aims at helping both beginners and veterans dramatically save time spent on
8-bit MCU programming. It provides the following functions:

• Generates C source files for the target device simultaneously when the user sets a peripheral.

• Supports the KEIL project format by:

– Generating \*.uv2 project files. They support KEIL uVision 4 and 5.

– Generating each device’s header file (e.g. MC95FG308.h).

– Generating the startup.a51 assembly code file.

– Generating a single source file (main.c) or multiple source files (main.c, interrupt.c,
and peripheral.c).
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Features of CodeGen8

• Displays the following:

– Device header file(s)

– Device source file(s)

– Package view
• Provides a peripheral setting pane.

• Provides a package view that shows pin assignment and allows the user to set port functions.

• Manages CodeGen8 project files automatically.

• Generated source file contents are changed as soon as you click for device setting changes.

3.1.2 Getting started with CodeGen8

Perform the following:

1. Execute CodeGen8 to open the following dialog box; among the controls, only device name,
package type, and Cancel will be active.
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Features of CodeGen8

2. Select a target device.

3. Select a device package.
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Features of CodeGen8

4. Type the project name, and the New project button will be enabled.

5. Click on New project.

CodeGen8 (8-Bit MCU Code Generator) Page 14 / 42 Version 1.0.0



Features of CodeGen8

6. If you have created more than one CodeGen8 project, the dialog box will list them as shown
below:

• LAST project: Load the last project.

• NEW project: Create a new project.

• Load a project: Load a project from the list of previous projects.
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Menu descriptions

7. On the main screen below, configure your device.

3.2 Menu descriptions

3.2.1 File
The File menu includes the following items:
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Menu descriptions

New or Load Project

This menu item closes the currently open CodeGen8 project and prompts the user to create a new project
or load a project from the list of previous projects.

Multi ‐> Single source / Single ‐> Multi source

Single-source project:

CodeGen8 generates a single source file named main.c. This file contains the main
function routine, interrupt vector functions, and peripheral functions. It is automatically
closed when a multisource file (e.g. interrupt.c) is opened.

Multisource project:

CodeGen8 generates main.c, interrupt.c, and peripheral.c source files.

• The main.c file contains the main function routine only.

• The interrupt.c file contains interrupt vector functions.

• The peripheral.c file contains each peripheral’s initializing functions.

You can see the file structure in the File View pane.
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Menu descriptions

Generate source file(s)

CodeGen8 saves the following files:

• Header files

– Device header file, for example, MC95FG308.h

– Function definition file, for example, func_def.h

• Source files

– Assembly file that includes the initialization code, for example, startup.a51

– C source program file, for example, main.c, interrupt.c, or peripheral.c

• KEIL project files

– It contains the target device, file management, etc., for example, projectName.uv2.

If there is a warning appearing because of errors in the device settings, it prompts to choose whether to
continue or not. You can see the warning in the Output pane.
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Menu descriptions

Call KEIL compiler

This menu item saves the current header file(s), source file(s), and KEIL project file, and calls the KEIL
compiler as shown below:

If there is a warning appearing because of errors in the device settings, it prompts to choose whether to
continue or not. You can see the warning in the Output pane.

Print…

It prints the current child window. The child windows include the view of each source code (header, C)
and a package view.

Version 1.0.0 Page 19 / 42 CodeGen8 (8-Bit MCU Code Generator)



Menu descriptions

Print Preview

This feature allows you to see exactly how your pages will look when they are printed out. Using this
function, you can save paper right up until final printing. Print Preview is easy to use, and you can print
directly from this screen by clicking on the Print button or printer icon.

Normal view Print Preview

Print Setup…

This command displays the standard Print Setup dialog. You can choose a printer and select other
options.

Exit

This button helps quit from CodeGen8 immediately.

3.2.2 View
The View menu controls the display of the CodeGen8 software frame and child windows.

Add vertical TAB group

It provides the functionality for tab control. The tab control displays a dockable window with flat or three-
dimensional tabs at its top or bottom. The tabs can display text and images and can change colors when
active.
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Menu descriptions

Toolbars and Dockable Windows

This menu item shows or hides different child views.

Customize

It allows users to change the debugger software GUI environment to suit their preferences regarding
Commands, Toolbars, Keyboard, Menu, and Options.

The Commands tab provides choices to modify the composition of each menu’s sub-items.
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Menu descriptions

The Toolbars tab allows you to switch between toolbar styles.

The Keyboard tab allows you to define shortcut keys. You can reset them or restore them to the default
settings.
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Menu descriptions

The Menu tab is to define the menu style.

The Options tab provides settings regarding toolbar tip display, icon size, etc.
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Menu descriptions

Status Bar

It turns on or off the Status bar, which displays information on the current state of CodeGen8.

Caption Bar

It turns on or off the Caption bar, which displays the device name, package type, and project name.
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Menu descriptions

Application Look

It changes CodeGen8’s GUI look at once.

GUI selection

Different GUI styles

Version 1.0.0 Page 25 / 42 CodeGen8 (8-Bit MCU Code Generator)



Control panes

3.2.3 Help

It shows the CodeGen8 version and copyright, and the programmer’s name.

3.2.4 Toolbar
This provides an easy and single-click access to the most frequently used commands.

3.3 Control panes

CodeGen8 provides three control panes for developers. The information displayed on those panes
include project status, device settings, and warnings. All panes except the child windows are dockable.

What is docking

Docking is manipulating a window to align it with the edge of another window or to move it into another
window.
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Control panes

3.3.1 File View pane

It shows the file components of the current project. Single-source projects generate main.c, while
multisource projects generate another two C files (interrupt.c and peripheral.c). The rest files
(startup.a51, func_def.h, and device header) are common. You can open any file by
double-clicking on the file name.
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Control panes

Example: Single-source project Example: Multisource project

3.3.2 Properties pane

It shows the peripherals of the current project. This is the most important component of CodeGen8.

• This lists specifications of each peripheral.

• The peripheral settings are viewable and editable.

• If you change any of the settings, the source program is generated automatically.

• Some peripherals support only one function; an attempt to enable multiple functions pops up a
warning message.

• If a peripheral setting conflicts with other peripherals, the Output pane displays it.
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Control panes

Case 1

Suppose that the system clock is 4 MHz, and you want to use UART at 9600 bps. But a baud rate of
exactly 9600 bps cannot be rendered at 4 MHz. CodeGen8 calculates and displays the nearest bps and
generates the source program.

Your input: 9600 bps CodeGen8 calculation: 9615.38 bps

Case 2

Suppose that you are using MC95FG308, whose Timer0 and Timer1 are 8-bit timers. If you want to use
Timer0 as a 16-bit timer, Timer1 must be extended to the upper 8-bit timer of Timer0. This means, if
Timer0 is set to 16 bits, you do not need to set Timer1. CodeGen8 disables editing of Timer1.
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Control panes

Timer0 and Timer1 are separated Timer0 and Timer1 are merged

You do not need to know all the peripheral specifications because it is straightforward to set all the
peripherals. If you want to make more detailed settings, then you need to understand all the peripheral
specifications.

3.3.3 Output pane

It shows warning messages regarding peripheral settings or conflicts between them.

You must clear the warning messages by changing the device’s peripheral settings. Else, it generates a
C source program omitting some peripheral settings.
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Child windows

3.4 Child windows

The child windows operate differently from the previously mentioned panes. They include a source file
view, virtual source program view, and device package view. They all are simpler views and do not
provide editing functions.
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Child windows

3.4.1 Source program view

It shows text files or virtually generated source code files with line numbers.

It does not support file editing but allows the user to copy the text to the clipboard. Tab size displayed in
the view is fixed at 4. C or assembly keywords and comments are colored for an enhanced visibility.
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Child windows

3.4.2 Package view

It shows the current target device’s package shape and its pin assignment.

You can easily read the status of each pin based on its color:

Pin color Meaning
Red This pin is a power source pin.
Blue This pin is a ground pin.
White This pin is not assigned a function yet.

Yellow
This pin is assigned a specific function.
Assigned function is to change the text color to red.
Assigned pin list is displayed under the package shape.

Pin color Meaning
Red This pin is a power source pin.
Blue This pin is a ground pin.
White This pin is not assigned a function yet.

Yellow
This pin is assigned a specific function.
Assigned function is to change the text color to red.
Assigned pin list is displayed under the package shape.
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Child windows

You can set a port function both in the Properties pane and from this window. By double-clicking a pin,
you can edit port properties using the following dialog box:

CodeGen8 (8-Bit MCU Code Generator) Page 34 / 42 Version 1.0.0



Output files

Chapter 4. Output files

4.1 Header files

CodeGen8 generates two header files as shown below. They are not affected by whether they belong
to single-source or multisource projects.

Example: Single-source project

Example: Multisource project

4.1.1 Device header

The device header file contains the peripheral definitions. This is the real text file located in the device’s
Library folder. You do not need to modify this file when you are working in a KEIL environment.
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Header files

The following is an example of MC95FG308.h:

4.1.2 func_def.h

This file contains function definitions. This is a virtual text file that does not exist in any folder. The function
name, function body, and comments are assigned by CodeGen8 automatically. You can recognize each
function’s operation easily with the function name and comments. You do not need to modify this file
when you are working in a KEIL environment.

The following is an example of MC95FG308.h:
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Source files

4.2 Source files

These files contain the skeleton of the real source code. The function name, function body, and
comments are assigned by CodeGen8 automatically.

Example: Single-source project

Example: Multisource project

4.2.1 startup.a51

It contains device memory and stack initialization code. This is a real file located in the device’s
Library folder. You do not need to modify this file when you are working in a KEIL environment.
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Source files

The following is an example of startup.a51.

4.2.2 main.c

The main.c file is the most important in C programming. Every C program starts with the main
function and ends with a null statement. The following are the characteristics of the main function:

• Any C program can have only one main function.

• This function is called by the reset vector.

• In MiCOM programming, the main function must not be terminated to prevent malfunction.
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Source files

CodeGen8 generates the main.c file very clearly and simply. It contains initialization codes only.
CodeGen8 generates slightly different main.c files in single-source and multisource projects. The
main.c file in a single-source project contains the main function, interrupt vector functions, and
initialization functions.

Example: Single-source project

The main.c file in a multisource project contains the main function routine only.
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Source files

You will see that the file contents are neatly separated.

Example: Multisource project

You can switch between a single- and a multisource project at any time.

4.2.3 interrupt.c

This file is optionally generated when you select a multisource project. This file contains the interrupt
vector functions only. Vector functions are automatically sorted by their interrupt numbers. Each vector
contains a comment that shows the interrupt source.
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Source files

You will see that the file contents are neatly separated.

Example: interrupt.c

4.2.4 peripheral.c

This file is optionally generated when you select a multisource project. This file contains MCU peripheral
functions only. All functions are automatically sorted by their names. Each function contains the
initialization code and comments.
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Source files

You will see that the file contents are neatly separated.

Example: peripheral.c
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